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SIGNAL

.< GND

+5V

gﬂﬁ 2.2 Tﬂsm%nﬁugmmm Infrared distance sensor (E18-D8ONK)

a = I ¢da
M3197 2.1 UFAINYaREAVRIV T HIBRTOUNT A

Pin
Red +5V DC
Green Ground
Yellow Output

a wa < da
A1919N 2.2 uamqmauummwuwmauwinm

Features
Power Supply 5V DC
Supply Current DC <25mA
Maximum Load Current 100mA

(Open-Collector NPN Pull Down Output)

Response Time <2ms
Diameter 17MM
Pointing Angle <15°

Effective From

3-80CM Adjustable

Detection of Objects

Transparent or Opaque

Working Environment Temperature -25°C+55°C
Case Material Plastic
Lead Length 45CM
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See

const int sensors1=10;

const int sensors2=9;

// the setup function runs once when you press reset or power the board

void setup() {

pinMode(sensors1,INPUT);

pinMode(sensors2, INPUT);

Serial.begin(9600);

// the loop function runs over and over again forever

void loop() {

int state1=digitalRead(sensorsl);

int state2=digitalRead(sensors2);

if(state1==LOW){

Serial.print("0");

telse{



Serial.print("500");

if(state1==HIGH){

state2=LOW;

delay(1000);

Serialprint(",");

if(state2==LOW){

Serial.print("0");

telse{

Serial.print("500");

if(state2==HIGH) {

state1=LOW;

delay(1000);

Serial.printin();

delay(10);

Wi]9
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Parameter standard Tyvpe of LED
standard high high
efficiency itensity
Dnameter {mm) 3 5 5 3
Max. forward 40 30 30 30
Current (mA)
Twpical forward 12 10 7 10
Current (mA)
Twpical forward 2.1 2.0 1.8 22
Voltage drop (W)
Max. reverse voltage (V) 5 3 5 5
Max. Power dissipation 150 1N 27 135
mW )
Peak wavelenght (nm) 690 635 635 635
+5V DC
.
R
n‘ ot
—

31 2.9 2993l50uUnd vedlaleanauas
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Supply Voltage | Low power LEIM 5 Standard LED High power LED
(V) mA nom) (10 mA nom ) (20 mA nom)
3 220 180 56
5 60 270 150
6 820 390 220
9 1.5k 680 390
12 2.2k 1k 560
15 2.7k 1.2k 680
18 3.3k 1.5k 820
24 4.7k 2.2k 1.2k
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=027 W

[ Zr A v Y IyA o w = 2_’, T [ a’tg
muumﬁmaﬂmmumuiﬁmm”lmmgmumﬂmgm 0.5 mmluhlﬂ
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U

Tuaeun 1: tsouso laloanlawueas (LED) whavveialulasneuInsaaeisigillae

g’/ ] ] v an J
> auaInavedlaTeanlasuaanp nunalnoaningay 13 ¥9dU05a
TulasaeuInsataod

3’, [ 1 ] 4 4
> e Tuaued laloaulauaananuan GND vosveialulasaouInsaaod

“ % '.

= Arduino = rirg

gﬂﬁ 2.11 mavenveda Arduino fu laloauldauas (LED) osda
Funeud 2 vhmaiFouTdaTilsuns unaee UsaE
int led = 13;
void setup() {
pinMode(led, OUTPUT);
}
void loop() {
digitalWrite(led, HIGH);
delay(1000);
digitalWrite(led, LOW);
delay(1000);
}
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1 @ 14 = 1 1
1A0NABNUY B5ALE3W( Arduino Shield) U5TLANA1L 9 1¥U Arduino XBee Shield, Arduino
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Arduino Uno R3

gﬂﬁ 2.14 ﬂﬂ%ﬂ Arduino Uno R3

< J A 1 a A 4 1 1
iWuweia Arduino NlATuANuiieinnigatiosnnaluims dawlugTusen
. 1 A o tg Y a o 14 dy 3 [ Y A A )
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2233 Tnssa$aiiug11uvesuesa Arduino Uno R3

3s0%m ICSP - d1wifu USB interface

114SPI} MOSI

104SPI) SS
3nterrupt 1
2-Interrupt 0

124SPI) MISO

‘/ 4nefm /O

2.3 Reset

2, y
1nefmUSE | 8 | Lol

% () 1\‘ 53109 ICSP : Atmega328

10.MCU : Atmegal6U2

9.993 Power jack 7-12 V 6MCU ; Atmega328

/4

7.we%m /O

8.wafm Power

A5{12C) SCL

Ad{12C) SDA

= y A ¢ .
gﬂ‘ﬂ 2.15 Tmaasnwugmﬁum‘uam Arduino Uno R3

TaseaF1eiugIuvesUesa Arduino Uno R3 11U 15znoudie
1. USB Port : 19§ 45uapnl Computer t1iodu Tvanaldsunsudr MCU uazae i
T¥ruvesa
2. Reset Button : (H11Ju Reset 19naiiiodosmsls McU Fumsvhaulny
< s A i
3. ICSP Port : Atmegal6U2 (Hunasanle 11/sunsy Visual Com Port U
Atmegal 6U2
Z dy o { A
4. 1/O Port : Digital /O #au@ v1 DO 94 D13 UenMAHLN Pin 923hniinou
INUALAIBI9Y Pin0,1 15190 Tx , Rx Serial , Pin3,5,69.10 ag 11 15uan PWM
5. ICSP Port : Atmega328 HunesanlyTUsunsy Boot Loader
< Hq 9 7 .
6. MCU : Atmega328 131u MCU #19uuv0o5a Arduino
3 L. Y o A < L o W 3
7. 1/O Port : uon9naziilu Digital /O ua? sufaswiluressudyaraeouiden
AUAU AO-AS
2 [
8. Power Port : Wiasavesvaiaiiadeemsnelilinuieesmeuen szneuden
F4
1Wi@89+3.3V,+5V, GND, Vin

9. Power Jack : 5010910 Adapter TagMusesuogszg 7-12 v
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10. MCU v043 Atmegal6U2 : 131 MCU Minmr il USB to Serial 1ag Atmega328
WhARDNL Computer WU Atmegal 6U2

AaaniAn vesuesa Arduino Uno R3

> 1950 ATmega328 Suftaria 16 MHz

» wueanuiunas 32 KB 15u 2 KB

» wefaldlvlides 789 12 v

> ﬁszﬁ’umﬁu"lﬂﬁﬂumsv‘inmuaxmﬁ’mumumag'ﬁ 5V

» (TTL) i Digital Input/ Output 14 ¥ (17 PwM 18 6 ¥1)

> 1 Analog Input 6 11 Serial UART 1 % o 1funo3adonsennsu
> fiaa2C 14 aSPIlyA

ArduinoDUE

51l 2.16 ve3A Arduino DUE

< { 4 A X a g { <
Wuveia Arduino Mfaeudi McU Tnumsniniamiluaszga AVR iaewmuines
[ Y g X U
AT91SAM3XSE(91327) 8 ARM Cortex-M3) unu M1 1vn1siszuianaiiivu uadanagduuy

TaaTisunsuves Arduino 100y

Y (% A <3 s @ . o 9 4 .
Yon2535239 : 1109910 MCU LT U105 NA19AY Arduino Uno R3 1921 1% U035 @ Shield 114

a ] v v 4 o 1
%1430 Library 1935nUAUU03A Arduino Leonardo 118 gl¥e1usniludesasindounou

iEARN
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2234 Tnssa$19Nug11Ue3U03A Arduino DUE

PWM Pins Serial Port

Reset

Native USB Port

Programming Port

suild Q/1 1e3siq

Vin ——

nnnnnnn

Analog Input Pins

= y A ¢ .
31]7] 2.17 Tﬂﬂﬁi]ﬁW‘Hg]ﬂ‘Uﬂ&Uﬂiﬂ Arduino DUE

TasaeriaveqUa’a Arduino DUE Huilsznaudie
1. USBPort : 19 v5unony Computer tvosuTraalusunsudh MCU uazae il
Truueia
2. Reset Button : 1Hu1Ju Reset 1o¥naiilodosmsl McU iFuiimsshalvy
< s A .
3. ICSP Port U84 Atmegal6U2 1ilunosanlsd1i/sunsy Visual Com Port U1
Atmegal 6U2
9 4 v

4. 1/O Port : Digital I/O @dus 91 DO 94 D13 UoANHUN Pin 3zmiinous
INUALAIBI9Y Pin0,1 131490 Tx , Rx Serial, Pin14,15,16,17.18 tag 19 13491 PWM
5. ICSP Port : Atmegal 6U2 Fhunedan 197151034 Boot loade
6. MCU: AT91SAM3XSE 111 MCU W19 uuveia Arduino

< . Y o A < Vo o < H 1
7. VOPort : Uan1nztilu Digital 1/0 uadufasuiluresiudayaaouidon A
U1 A0-All
8. Power Port : l¥liasavesvesadiodoamsnelnlinuiaesnieuen Useneuden

Y
Ilidee +3.3 V, +5V, GND, Vin
9. Power Jack : 51 TW91n Adapter Tao#i ussanogsznag 7-12 v
3 A o Y ad .

10. MCU ¥09 Atmegal6U2 111 MCU vty USB to Serial Iag
AT91SAM3XSE 92@an®nl Computer W1UAtmegal 6U2

< a o [ @ <
11. AREF : L‘]Ju"lﬂﬁs]}NENﬁﬂ’i‘iﬂllidﬂ‘]_l"llf]\‘islﬂ aUINDN
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. <3 s A 9 A U Jd ' J
12. Native USB Port : (Junoianansaldisounenvginsal aeala e and
ad J ¥ A A I EY
AduesA waz InsAnniens luau
. < ¢ dq v 4 "o < v 4
13. Programming Port : Hunesanly¥eunent USB Port Tasansnilulansunn
o o o . d H ]
TddmsusudeyannmadiouTaaTisunsy Arduino IDE taz 1iluni aunsodon

4
A lWidea9n Computer Taoneme

aaauiinnlivesuesa Arduino DUE

>

TulnsnouInsatass : ATOISAM3XSE 910 Atmel Wiieanusuvay 512 Alalud

usu 96 nlalud Tanuannsn USB-OTG shwihinilugilnsal USB Tead 1iennny

und Adueda wazamnialuuly

>

YV VYV YV VYV

ATy © 84MHz

Tiligarhan : 33V

EJ'm”qu,?:m%unm L7912V

WOIADUNALDIANA : 54 ¥ (TIMDIANA PWM 12 %03)

BUNABUIADN : 12 ¥o4 ANNAIBEA 12 T FUUTIAY 003 +33V
1PIANADUIABN (DAC) : 2 ¥o4 ANWAzidoa 120 a 1¥usedu 0 Ba +33V
ﬁaﬁaﬁﬁ%’mp . 1°C 2 %@, SPI, ITAG, CAN, UART 4 %@

NosARnnoABLN AADS - Wose USB lagldane microUSB
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2.2.4 2A30A 130 0YASAAITBY (Acrylic Resins)

510 2.18 i uozA3an 130 azA3AAISTU (Acrylic Resins)

2.2.4.1 9zA3an/HUDZASAN

A d3 a o J a o A o 9 1 Y o o
ﬂﬂlﬂuWﬂ@]ﬂmm%l@mﬂﬂﬁﬂgﬂuurl%ﬁ"I‘LlﬂfJNﬂ'JN"1]31\1114511?1@9]?”14?!53% qa1nsy
< R, a a o g 1 o 1 1 o A A ~
Lﬂuﬁ”l'i@ﬁﬁﬂiuﬂ?ﬁﬂﬂ@]ﬂﬂ@]ﬂmm9”\1“]f’Nfﬂ']ﬁﬂTfJ!!ﬂﬂ']ﬂﬂi'JLiﬂu NI NINYATINNTITUN

1 k2
LﬁEJ’JGIQIIEN ‘VNGluqi,‘ﬂf)gﬂiﬁﬂlﬁﬁ’lﬁ'WﬁiUﬂTﬂQ@ﬁWﬁﬂiill uazuwuazﬂiaﬂw%w faanacnIan

dmsuaulumuaeg

aa A aa a . . < a 14 a s A Y
pzAIAN W30 DA ANITTY (Acrylic Resins) ITuwodinos naz Tanodiuesmasonla
NnNIARLATaN LAz LT YBINIARLATAA LAz IBAINDIUPINTADE AT AN UgAT INTIa3g
& 3 S v Yy
Ao CH,= CHR Tasldarsaedau laun Methyl Acrylate, Ethyl Acrylate (t@& Methyl

'
aa Aa

Methacrylate naneenutuezasaanionldinnie Polymethyl Methacrylate (PMMA)
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2.2.42 lszipnveseznsan

nuldilualssianeiag fe

v
=1

aa < < J a a I < < <
1. 9 ATAAVDILLUN Lﬂumaﬂuwmﬁﬁmi%uﬂﬂgﬂlugﬂmmum SRRIRISTERT
aa A S <3 1 1 1 aa A a aa A < a
azﬂiaﬂmamugﬂgﬂuuwu HU UNUDEATAANIDNATTANDEATARN amﬂuiaiuwaa
14 a 14 a 14 a
LUDIVDUUMATLIOALDTIND T W%'E]IﬂW'E]ﬂL‘JJ@i“U@QL‘JJTnﬂ'im@]
aa 3 aa A A a Y a Jd
2. 9EATAALYAN !,‘]Juf)zﬂiﬁﬂﬂﬂgiugﬂﬁ1§ﬁ$ﬁ18ﬂ[}4ﬁC‘]Ulﬂi]']ﬂﬂ§$‘U’Ju ﬂTﬁW@ﬁLilf]ﬁllﬁ
EHFULVVATAL AN

A A v o PR ] = Y v A o 3 4
3. pzasanovatye 1 uaiunguuesaminyg dnnanluanyue vesannnds

2243 mslilselamiaasazAsan

® pzAsanltial uazodNatueznsan

]

I A 9 o a Glﬁld

inland #3lu

4
un mﬂumimﬁ’ucluﬂizmumiwaﬁw AANUNNNYIVDINUNTAN LIS

] a o oA 1A A @ < Y
TIUNTUUDINAANUNDU  LFU & T1TLNADUIT Lﬂuﬂu

® WuBZAIAAKIONANANDLATAN
< a o o Aaa 2 A g Y o < [} < [ A
HundanunvesezAsanvoanda ngnaugllnlianvazituewu erwihiwulanse
U= a Y v A 1 o o A’ v 9 [ ()
uruiiaanee HeulFauannluniaiaSeu wu shihe uasesanuasthu Jaeanuasihu

v E4
7 Yy

J @ < ' U <3 Y
w19 Qrasalal aaver veudniay nsougl navs \luau

51 2.19 mslilsglamivesezadanlumshmansameaigg
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2.2.4.4 axiam llvesuduezasan
— JamuTisalandrenszan
— NUMUADUIINTZUNN UTINA UAL TN INLIAFDUAUT1DINA

—numuasmsalvatestia snriumsaiazaty taznsanaIuINniNane

92AI0A TINDIAUNYNT A
—annsaauuaaaed  Inuadu ldauanudeams

~ ' v o ' ] = ~
— figavouddm nuasaNuSou taziinnumuiien
— Janmaaglne uaznuaemsvavIY

<3 o {
a1 vazavutlosnuanudouna

' L
- lugaanuin
=) \l an

2.2.4.5 MIWaauuazAIaAN

Y 4
a 1 aa a a @ v A @ J
ﬂTiWﬁﬂlLWu@Zﬂﬁaﬂﬁﬂﬁllﬂﬂuﬂﬁ ﬁ?iﬂiﬂﬂﬁ@ﬂmu%ﬁlﬂaﬂHﬂle\?Wﬁ@ﬂmcﬂ
A ] =3 a k) = aa Y ¥ o
Wiﬂﬁﬂllﬁﬂllaﬁﬂﬂllﬁ\‘] ﬁ'"liﬂﬁﬂwﬁﬁklﬂﬁa']ﬂﬁa']ﬂﬁ L!ﬁﬁﬁJWQﬁUTWaTﬂgﬂL!ﬂﬂﬂﬂﬂu
uaz luii
[ aa A a aa a 9 aa I~
UAUBEATAAT IONATANDE AT O WaﬁleQTﬂﬂgﬂiaﬂGU@QLLmﬂﬂ']ﬂ
U o Y axy Y 1
NITUIUNITNITHAD ﬁ?iﬂﬁﬂﬂflﬂ 2B Vlﬂl!ﬂ

— ATTVIUMITHABLULABLIBY (Continuous Casting Process)

— nszuIumsvasuuy lumeiiies (Batch Casting Process) LW NIEUIUMIHABLUY

1¥ad (Cell Casting Process)

9 : 9
ANMIANANUVBIINEDIID AID NITVIUMSHADUUUADIE DIZINA T UTUADUA RO

' '
A o w A

voameruaoudunMaandoun drunszurumsnasuuy lueaiioavzinaluniivaonse

T
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IS d‘d \ aa
2.2.4.6 a1ANNNNANdITAIAN

A A aa

mimuﬁmagumq BeANIN

_nsalalasnanin 40%
~nyalalasrigoosn 40%
—n3aluesn 40%
- n3adaIn 98%
— ANUNNNT A
_ aaelsvledu
_lanasTidnaau

Aa A 14
— madunaolia

4 4
— mMSupuIanIzAae 158
—prylau
—na
—1pa
—alau

— Tngou

A A Y U aa
AAUNUNAUBDYA DO A IO

— NIAOLTAIN 5%

—nsalasin 40%

— NIATFATN 10%

- nyalalasvigossn 10%
—nsaluasn 10%

- nIadaIn 30%
~ponluiienlaasenlyd 28%
~ TaReumsveia 20%

_amdeuleason s 60%
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2.2.5 XBee

310 2.20 XBee

é’numzmsﬁnmmm XBee

1 ya [ dy
LL‘U\‘]llﬂL‘ﬂu 3UUY ANU

. IS Y A 9 A A A 1 1 . v
1. Coordinator YU UINTINNNTIADAT L"'If@iJIENLﬂi’E)EUTEJ T¢I End device NU
Router ‘Vi%ﬁ] Coordinator A1) Coordinator @glj’lﬁlﬂwu ﬂd‘iﬁl Coordinator A1) Router
o o [ d' Y v c’d’ A 1 Y ’.f [ [ d'
mwuﬂmlmmmg‘lwﬂuqﬂﬂmmgﬂmﬂmimnﬂ ]’lilﬂlﬁclﬂ U fﬂllﬁﬂﬂf‘ﬂiljﬂﬂ
o Y 2 A Y o . . .

M3IAMIFUMS Faiieulany Full Functionality Device: FFD

< o : o o < 7=
2. End-Device 1Huginsaimemaga davziulddyapannduseiilatema

9

Tagnldnadesarudrlunisiiauien 1y Reduced Functionality Device : RED %30 Full

. . . ~ X o & saq ¥
Functionality Device : FFD wmmmuagﬂmmummm%
A Y Aw 1Y ) 0 A ) q g
3. Router ¥HUIMNTUAIUDYA ELL!LETL!‘VIN@]N‘]EU?N!ﬂi@ﬁlﬂﬂllﬂg1’?1Lﬁ1!1/]”|\1‘1/]1ﬂﬁ1’]§(ﬂ
= v v Yy A
GBQ‘DZG]@Qi%L’JﬂWH@Emeﬂ
AoauiAlaeia

o anudlumsihaiu: 2.4 GHz
® e IMd: Ua1we1MALUY Whip
o ] A
® szazimMalusn: gaga 300 W Wiodszina 100 uas

o Y . . =2 J A
®  FTYTMNITNANLI (LUY Line-of-Sight) : FA 1 Vlllﬁ n3Uszinu 1,500 a3
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Maaae: 60 mW (18dBm)
anuhlumssudadaain: -100dBm (1% Packet Error Rate)

o 4 ° 1 s 2 A 9 9o 3
MIMIUYDIVINDIA: ANTDMUUANUNNEINALIF X-CTU 1o lihanihy
a 3 ) @ [ 3 I aa = a
aunapIdend M UNI asdyaaedeniiuainea Anwazdea 10 U
BunaeIANAAINeA

Y
YUIA: 0.96 x 1.297 117 1150 2.438 x 3.294 LHUALIAT

F4

Iides: 28 8933 v

nszua W iodsdoya 215mA Sudoya 55mA eend 10UA TuTrnuaaanaaan

nlides 133 v

ag Y =
RUHANIHIIY: -40 D3 85°C

AaaudaIumMsaeasvoya

annsahauiluglnsaiinaaesuay aavl1a

sas1oneneadoyaruaaL Ing: 250,000 Tare3und

oATIMIDNENOATOYADYNTN (VOALTA) : 1,200 D9 115,200 UnapIuii

sty Taseviedoyafisossu: ganega (Point-to-Point) JARBYAIEYA
(Point-to-Multipoint) taztdnu lanugnsaln1umasgug Iy IEEE 802.154
Madoniealasa: PAN ID %09 (Channel) Hazioaasd (Addresses) AIMSULOAATH

gnsamyuasiaueaas aldnnda 65,000 s¥d
malulaglumsnsgaendu : DSSS (Direct Sequence Spread Spectrum)

[ o Y o 1 J 4
FJONTUMIMANUNUUY API 11ag AT Command mmmmwuﬂ"l,ﬁ’mumq FFN1LIT
X-CTU

MITUTDINATFIU : aNTFoNiTN (FCC Part 15.247) OUR-XBEEPRO
- uAUIA (IC) 4214A XBEEPRO

- ¢151 (CE) ETSI (1M1a3a3gaga 10 dBm)

Q

v
I

- 1y 005NYCA0378 (MMAIAgIga 10 dBm)

a
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v d o o
ﬂ]i‘i]ﬂ"llﬂ?»l@.ﬁ XBee uaxﬁanmﬂunnm&m

/

Pin: 1.—~(= L Pin 20
, . W e
Pin l_"Ef = Pin 20 iy p——
* F s 2 : :‘{&E:
PNETEEE . : PRO * .
. : Pin 10 =« i Pin 11
» -
N H

Pin 10-= ~Pin 11

310 2.21 XBee #az M3ITAVI1VD9 XBee

3 o d o o
M31371 2.5 M3davluga XBee sazilangulumsina

d' d’ o
UIMN FOUVYNITNINIU

1 Vee 199 1W1dee +3.3V

J ]
2 | DOUT : vuodnadadoyaounsy

3 | DIN : BunaSUTeyaoy N Y

4 | D08 : MULENAAIADA ¥ 8

5 RESET : ¥15t5a1ian (Active “0”)

4 1 J @
PWMO/RSSI : VUDIANA PWM ¥4 0 LUAZVUDIANALTANANNLLIIVOINITIU

oy

7 | PWMI : vuedne PWM ¥o4 1

8 Tulefau

DTR/SLEEP_RQ/DI8 : v1dunaiudyaimldvgahanudn Tnuaadl

99 Q

A < a an ]
NiIov L']Juﬂﬂﬂu‘ﬂﬁﬂ’ﬂﬁ@a"b’@ﬂ 8

10 | GND : 9¢n3129

a 3 a J aa
11 AD4/DIO4 . VIDUNABUIDDN 4 ﬁ%@"’lﬂﬂuﬂﬂlﬂ'lﬂﬂﬁﬂﬂﬁ@a 4

CTS/DIOT : Bunasudnausamsdatoyaanlaad (Clear-To-Send)

12 [ [ T 9 A < a 4 an

T lumsmuauianizmssvdidoya wiedundunaeidnadinea 7

ON/SLEEP : 410#@an1umsaiiau
13

“17: agluTnuariaulng, <27 : egluTnuaa@il

1 v Y Aa o o o < I aa

VREF : Maouseauenesdmivluganasdyaraoudenuaineanisluy
14

Xbee

S A U a <

Associated/AD5/DIOS : VWAAIAUMIVFOUAD HIDVIDUNADUIADN 5

15

a J aa
ﬂ%ﬁ] VIDUNADIANAAINDA 5
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¥ v d o
9199 2.5 miimsuﬂug]a XBee tazansulumsmhau(ae)

4 1

RTS/AD6/DIO6 : vuodnaudsnumioulumsdadoya (Ready-To-Send) 19
16 @ o 19 A I a <3 A 3 a an

AIUANTINIEMITUTITRYE HIluvduNADIGeN 6 viaolluvdunaATnoa 6
17 AD3/DIO3 : VI3UNADUIADN 3 13D MDUNALDIANARIADA 3
18 AD3/DIO2 : VIBUNADUIADN 2 13D WDUNALDIANARINDD 2

a < a ana

19 AD3/DIOI : 1BUNADUIABN | W30 WDUNAIANARIADA |
20 ADO/DIOO : BUNABUIABN 043D MDUNALDIANARIADA 0

= o d d v i d ¢
ﬂ1i!ﬂl€miﬂi!!ﬂﬁdﬂ31Jﬂ3J‘§$1J‘1Jﬂ1iTI1@1”%6@815ﬂ!!’$5!!ﬁ1$ﬂ15ﬁ iNQ‘]Jﬂﬁmﬁﬂ NI

9
Tumsi@ouTisunsinin Tuniasunazniads 15119 XBee Tumsdadoyanini
Y
Az Aot ld XBee masunazmndsansodnaenuld TaeldTsunsy X-cTU s

Y
Taaail

9
1. AagaTlsunsy X-CTU neirvuaigaaslunouiiunes

9 v
2. AN Tm;]a XBee awuua%ﬂ XBee USB Adapter mgﬂ‘ﬂ 221

51 222 MmsAaAsluga XBee a9UUDD3A XBee USB Adapter

L'l
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3. JaTusunsn X-CTU wagnatfu Test INONAAOUMIIFOUADIZHIN XBee )
Talsunsu X-CTU Mansodanony lansely asgii 223 windaseni laue

Y 1 a v F
ﬂi’lﬂaﬁu’]@l’l\umﬂNaﬂ'ﬁﬂﬂﬂ@uagﬂl'ﬂi&!ﬁ%@\i XBee lu@ﬂ@luﬂ\igﬂﬂ 2.24

E_EK—CTU ||:| | 2 |

About
FC Settings | Range Test I T etminal I M odern Configuration I

— Com Port Setup
Select Cam Part

Standard Senal over Blueta, [CORMA4] Baud IEIEI:II:I - I

Standard Serial over Blueta,. [COME]

IJSE Serial Port [COMI) e INEINE ,I
Ciata Bits |E 3
Parity INDNE :]'
Stop Bitz |1 vI

Test / Quem

Host Setup | User Com F'u:urtsl M etwork Interfacei

— AP ~ FReponze Timeout

[~ Enable &FI
Timeot | 1000

[T Use escape characters [ATAR = 2]

—A&T command Setup
ASCH Hex

Command Character [CC) I E | 2B
Guard Time Before (BT) | 1000

— Modem Flazh Update
[ Mobaud change

sUM 2.23 nrhealdsunsu X-CTU

U
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’
Com test / Query Modem

Communication with modem. . OF,
tadern firrmware vergion = 2047
todem pe = xB24-7B

Serial Mumber = 13420040440 3680

=h.

1

2.24 HINAMDINANMIAAAD

@ g a {3 U
4. vidanniunan lUfuil Modem Configuration 1@nefy Read 11n50U Modem

Parameter and Firmware ﬂxﬂﬁﬂgﬂ”ﬂﬂga%jumaﬂu@a XBee (Modem Type) ¥o

Y J o o s ' A J o {
ﬁaﬂsvuwmmamnawmmﬁhmm LRAZATNITTUADTANE @Ngﬂ“ﬁ 2.25

.
BB comg) x-cTU

S

Modem  Parameter Profile Remote Configuration...  Versions...
PC Settingz l Ranage Test I Terminal  Modem Configuration I
—Modem Parameter and Firmware ——— Parameter Yiew - — Profile —— — Yersions 3
FRead Wribe I Restare l Clear Screen Save Diownload naw

[T Abways Update Firmware Showe Defaults Load WEISION. .
Modem: XBEE Function Set W ersion
|<B24-2B _~| |ZIGBEE COORDIMATOR AT B ET
Ea ” ehy l=:_it'||:| -

----- B (9910 - Pak 1D

----- B (FFE) 5C - Scan Channets

----- B (3150 - Scan Duration

----- B (0125 - ZigBee Stack Profile

----- B (FFIrJ - Made Jain Time

----- B (99) OF - Operating PaM 1D

----- B (3605) OI - Operating 16-bit PAM 10
----- B (121 CH - Operating Channel

----- B (2] MC - Mumber of Femaining Children
EZ3 Addressing

----- B (124200) 5H - Serial Mumber High

----- B (40440980 5L - Serial Number Low
----- n [0] MY - 16-bit Metwark Addreszs

----- B (0 DH - Destination &ddrezs High

----- B [FFFF) DL - Destination &ddress Low
----- B (1Ml - Mode Identifier

----- B [(1E) MH - Maximum Hops

----- B (0] BH - Broadzast B adiuz
..... B R - O TR SO

m

Chatige networking settings

[COM3

[96008-H1 FLOW:NONE XBZ4ZB WVer20&7 |

31 225 wamse M ININga XBee NOUNIAIAT
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S [ 19 Y o o g Y v .
5. aammssuaeveyaliny XBee Tae maasmln 1 duthuTnua Coordinator

v 4 " W
(Rx) 1oz 90 1 @niuTrua Router (Tx) TagUmM It ouaDAMLL LY

(B8 come) x-cTU = 2 |)

Modem  Parameter  Profile  Remote Configurstion..  Versions...

P Settings | Range Test | Teminal  Modes Corfigation |

|- Modem Pasameter and Firare - Parameter View | - Profile Vessiona 1
Read | Wite | Fedtoe | OemScieen || Sawe | |

| T Adways Update Fimmsre }} Show Defauks| | Load |~ versins I

4Mod|m XBEE Funchon Sel Verson

| ] IGBEE COORDINATOR AT ~l [ =]

B so Scmu ) E

I~ [ 10125 - ZigBes Stack Prolis
i~ [ FF)NJ - Node Jon Time L4
B (3310° - Dpetatng PAN 1D
[ 13505) 01 - Operating 1664 PAN ID
B 1121 CH - Operating Charend
B WINC - Humber of Remaning Crildien
=23 Addessing
I @ N38200) 5H - Senial Nunber High
I~ B 14044D38D) SL - Serial Nunber Low
MY 1608 Notwork Addoss
esanaton oss
W]DL - Destination Addess Low
T T - Node Iazniiee -
B 1E)NM - Mavsrrum Hops
B 11BH - Broadeasst Radus
B 5T AR . Marein Dirm R tn Renacdemet Time

Changs retwerking seitrg:

LWMS 15600 8N1 FLOWNONE  XB2478 Ver 2047

31 2.26 138381 XBee 1UY Coordinator

8B [COM10] X-CTU

Modem  Parameter Profile Remote Configurstion.., Versions..

PC Setings | Range Test | Temnal Modam Configuration |

Modess Parameter and Fitmwware Pasametes View - Profie | Vessions
Resd | Wite | Restws | CewSoesn| | Seve ||| powniosd new

= umuwurm Show Delats| | Load | vessions. .
Moden XBEE  Furchion Set Ve
lxaz:a ] [ZiGBEE ROUTER AT ] [22a7 ]
) can le I
' (3) 50 - Scan Dusation =
- [ (0025 - ZigBe Stack Proke J

- B (FFYNJ - Node Join Time
B (0)NW - Netwaark Walchdog Temeout
- B (0)4V - Dharrel Verfication
B ()N - Join Nottication
- [ (950 0P - Opeesting PAN 10
[ (3605) 01 - Opesating 165t PAN ID
B (12)CH - Operatng Charcel
- [ [CINC - Number of Remaining Chidsen
SR=]

Addressng
- [ (134200 SH - Sesal Number High
.[MAAC]SL Serial Numbes Low

(COMI0 [ 95008N-3 FLOWNONE XB242B Ver22a7

31 227 138371 Xbee 1Y Router
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Y
6. mﬂuuﬂmju Write 308NAJ FunamuaneavesrtIang Modem Configuration 9%

9 A Y d o < @ A ] o '
UAAUDANUNDLIITDIUNTUN NI mmﬂumgﬂﬂ 2.28 AP NNITNHUAAN

< @
LI UY I

BB [cOM9) X-CTU L=l [
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const int sensors1=10;
const int sensors2=9;
// the setup function runs once when you press reset or power the board
void setup() {

pinMode(sensors1,INPUT);
pinMode(sensors2,INPUT);

Serialbegin(9600);

b

// the loop function runs over and over again forever
void loop() {

int state1=digitalRead(sensorsl);

int state2=digitalRead(sensors2);

if(state1==HIGH){
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. . Yy < d o A A g Y (]
Serial.print("0"); s 0uFUIeiAIN 1 Uanilu HIGH 1vuaasa «0”
else{

. . Yy < ¢ @ A A g Y 1
Serial.print("500"); couFUIeIAIN 1 NAntle Low I¥ugasn <5007

if(state2==LOW){

Serial.print("0"); } - duduesdain 2 lanih Low lduaasm «o”
delay(1500); ;?]LEIEGJ' 1500 ms
}

Serialprint(",");

if(state2==HIGH){

. . Yy 2 ¢ v A A d v '
Serial.print("0"); s ouFuasan 2 Uauile Low lduanaan «0”
telse{

. . vy 2 ’ v A A0 d ) '
Serial.print("500"); s ouFusasadn 2 Uauile Low lduanaan “500”
state]=0; SIS werasan 1 Ianumny <o
delay(1500); - A1ad 1500 ms
¥
Serial.println();

= J
delay(10); ; Alag 10 ms
¥

333 lnaldsunsudmSumsuansnalag Processing

import processing.serial.* ;

import gifAnimation.*; // import the gifAnimation library

Serial myport ;

Gif myAnimation; // create Gif object called myAnimation

int val, screen_increment, old x =0, old y =0, old x1 =0, old y1 =0;

String inString ;
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int If =10 ; /Linefeed in ASCII

int numSensors = 2; //we will be expecting data feed from 2 sensors

int sensors[]; //array to read the 2 values

int pSensors[]; //array to store previous readings used for comparing actual reading with
last one

int time =0, t0=0, t1=0, flag0 = 0, flagl =0, In= 0, Out =0 ,total=0 ;

int val0_old = 600, slope0, vall old = 600, slopel, peaksO = 0, peaksl =0 ;

int screenstep =3 ;

PImage img;

void setup()

{
size(displayWidth-100, 800);

myAnimation = new Gif(this, "Gif in out 2.gif"); // load animated GIF file from
// the data folder, replace
/1 "img01.gif" with the name of
//'your GIF file

myAnimation.play(); // play the animated GIF

printin(Serial list());

String portName = Seriallist()[0];

myport = new Serial(this, portName, 9600);

myport.bufferUntil(If); //read bytes until you get linefeed (ASCII 10)

background(288,24,24);

strokeWeight(1) ;

stroke(255,255,255);
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line(100,10,100,600) ;

textSize(30) ;

text("ADC values from Infrared sensor", 400, 670);
textSize(15) ;

text("by School of Telecommunication Engineering, SUT", displayWidth-480, 690);
textSize(20) ;

text(0, 40, 600); line(90,600, 100,600) ;

text(1, 40, 525); line(90,525, 100,525) ;

text(200, 40, 400); line(90,400, 100,400) ;
text(300, 40, 300); line(90,300, 100,300) ;
text(400, 40, 200); 1ine(90,200, 100,200) ;
text(500, 40, 100); line(90,100, 100,100) ;
text(600, 40, 20); line(90,5, 100,5) ;
line(100,600,displayWidth-100,600) ;

text(100, 100, 630); line(100,600, 100,610) ;
text(200, 200, 630); line(200,600, 200,610) ;
text(300, 300, 630); line(300,600, 300,610) ;
text(400, 400, 630); line(400,600, 400,610) ;
text(500, 500, 630); line(500,600, 500,610) ;
text(600, 600, 630); line(600,600, 600,610) ;

text(700, 700, 630); line(700,600, 700,610) ;
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text(800, 800, 630); line(800,600, 800,610) ;

text(900, 900, 630); line(900,600, 900,610) ;

text(1000, 1000, 630); line(1000,600, 1000,610) ;
text(1100, 1100, 630); line(1100,600, 1100,610) ;
text(1200, 1200, 630); line(1200,600, 1200,610) ;
text(1300, 1300, 630); line(1300,600, 1300,610) ;
text(1400, 1400, 630); line(1400,600, 1400,610) ;
text(1500, 1500, 630); line(1500,600, 1500,610) ;

text(1600, 1600, 630); line(1600,600, 1600,610) ;

void draw()

int s = second();

int m = minute();

int h = hour();

textSize(25);

fill(55);

text(h+":"+m+":"+s, 220, 50);}

if((pSensors != null)&&(sensors !=null)) {



void serialEvent(Serial myport)

inString = myport.readString() ;

if (inString !=null)

inString = trim(inString) ;

pSensors = Sensors |

sensors = int(split(inString,',"));

for (int sensorNum = 0; sensorNum < sensors.length; sensorNum-++) {

print("Sensor " + sensorNum + ": " + sensors[sensorNum] + "\t");

printin();

val = int(inString) ;

int val0 = sensors[0],vall = sensors[1];

time =time + 1 ;

strokeWeight(5) ;

stroke(255,255,255);

color ¢ = color(255, 204, 0); // Define color 'c'

fill(50); //textSize(50) ;
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textSize(20) ;

image(myAnimation, 200, 10);

fill(50) ;

textSize(50) ;

text(In, 280, 270) ;

fill(255);

text(Out, 980, 270) ;

int visitors = total ;

fill(288,24,24);

text(visitors, 530, 170) ;

strokeWeight(5) ;

stroke(255,255,255);

line(old x, old vy, screen increment, 600-val0) ;

old x =screen_increment ;

old_y =600 - val0;

screen_increment = screen_increment+10 ;

stroke(0,0,0);

line(old x1, old yl, screen_increment, 600-vall) ;

old x1 =screen_increment ;

old_yl =600 - vall;

if (val0 > vall){
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In=In+1;

if( vall >val0 ) {

Out=Out +1;

total=In - Out;
screen_increment = screen_increment+ 5 ;
textSize(20) ;

if (screen_increment > displayWidth-100)

pause();

background(288,24,24);

strokeWeight(1) ;

stroke(255,255,255);

line(100,10,100,600) ;

fill(255,255,255);

textSize(20) ;

text(0, 40, 600); line(90,600, 100,600) ;
text(100, 40, 500); line(90,500, 100,500) ;
text(200, 40, 400); 1ine(90,400, 100,400) ;

text(300, 40, 300); line(90,300, 100,300) ;
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text(400, 40, 200); line(90,200, 100,200) ;
text(500, 40, 100); line(90,100, 100,100) ;
text(600, 40, 10); line(90,5, 100,5) ;
line(100,600,display W idth-100,600) ;

text(100, 100, 630); line(100,600, 100,610) ;
text(200, 200, 630); line(200,600, 200,610) ;
text(300, 300, 630); line(300,600, 300,610) ;
text(400, 400, 630); line(400,600, 400,610) ;
text(500, 500, 630); line(500,600, 500,610) ;
text(600, 600, 630); line(600,600, 600,610) ;
text(700, 700, 630); line(700,600, 700,610) ;
text(800, 800, 630); line(800,600, 800,610) ;
text(900, 900, 630); line(900,600, 900,610) ;
text(1000, 1000, 630); line(1000,600, 1000,610) ;
text(1100, 1100, 630); line(1100,600, 1100,610) ;
text(1200, 1200, 630); line(1200,600, 1200,610) ;
text(1300, 1300, 630); line(1300,600, 1300,610) ;
text(1400, 1400, 630); line(1400,600, 1400,610) ;
text(1500, 1500, 630); line(1500,600, 1500,610) ;
text(1600, 1600, 630); line(1600,600, 1600,610) ;

textSize(30) ;



Wl |47

text("ADC values from Infrared sensors", 300, 30);

textSize(15) ;

text("by School of Telecommunication Engineering, SUT", displayWidth-500, 560);
textSize(20) ;

strokeWeight(5) ;

creen_increment = -50 ;

old x =-50;
old y=0;
old x1 =-50;
old yl =0;

H
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m3l¥uldsunsy  Arduino IDE

1. sl Tnaalusinsy Arduino IDE #1 849 http://arduino.cc/en/Main/Software 41821

9
msaaad lUsunsu

€ - X [ www.arduino.cc/en/Main/Software

ARDUINO

Home Buy Download Products « Learning + Forum Support « Blog LOG IN SIGN UP

Download the Arduino Software

‘Windows installer
ARDUINO 1.6.4 Windows zIP file for non admin install
The open-source Arduino Software (IDE) makes it easy to
write code and upload it to the board. It runson Mac OS X 107 Lion or newer
Windows, Mac OS X, and Linux. The environment is.
written in Java and based on Processing and other open-
source software Z
This software can be used with any Arduino board. Linux 64 bits
Refer to the Getting Started page for Installation
instructions, Release Notes

Source Code

Checksums

Linux 32 bits

0.0

51 1 wihamadulsd@wmSulnaalisunsu Arduino IDE

2. aand lonouved 1515y Arduino IDE A3z

arduino

51 2 Tonoulisunsu Arduino IDE
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3. ilontla Tlsunsund 9 nunmraeves IDE Asgl)

File Edit Sketch Tools Help

sketch_sep02a

Y

514 3 nihealilsunsu Arduino IDE

A Y A Y o S Aq Y A A s A £y
4. l‘lf]J‘VI Tools->Board ummm“lwmqﬂuuammhqm IﬂULa’t’]ﬂGlT’HfJU@iﬂﬂLiWIENﬂﬁ

Edit_ Sketch Help

V&) Auto Format %T h001 | Arduino 1.0.1
Archive Sketch

Fix Encoding & Reload

Serial Monitor O%EM

sketch_001

Board [l Arduino Uno
Serial Port > Arduino Duemilanove w/ ATmega328
Arduino Diecimila or Duemilanove w/ ATmegal68
Programmer *  Arduino Nano w/ ATmega328
 Burn Bootloader _ Arduino Nano w/ ATmegal68

Arduino Mega 2560 or Mega ADK

Arduino Mega (ATmegal280)

Arduino Leonardo

Arduino Mini w/ ATmega328

Arduino Mini w/ ATmegal68

Arduino Ethernet

Arduino Fio

Arduino BT w/ ATmega328

Arduino BT w/ ATmegal68

LilyPad Arduino w/ ATmegal68

Arduino Pro or Pro Mini (5V, 16 MHz) w/ ATmega328
Arduino Pro or Pro Mini (SV, 16 MHz) w/ ATmegal68
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmega328
Arduino Pro or Pro Mini (3.3V, 8 MHz) w/ ATmegal68
Arduino NG or older w/ ATmegal68

Arduino NG or older w/ ATmega8
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a v 9 ) A
5. Weu Tsunsuaarnn umuaall

const int sensorsl=10;
const int sensorsZ=9;
S/ the zetup function rans once when you press reset or power the board
vold getup() |
pinModes (sensorsl, INPUT) »
pinMode (sensorsZ, INPUT) ;
Serial.begin{S9g00) ;
}
S/ the loop function runs over and over again forever
vold loop() {
int statel=digitalFead(sensorsl):
int stateZ=digitalFead(sensorsl):
if (statel==HIGH) {
Serial.print("0"):
}else{
Serial.print("500™);
}
Serial.printi”,”™):
if (stateZ==HIGH) {
Serial.printc(”0™):
}else|
Serial .print("500™);
1
Serial.printlini):;
delav(500) ;
}

: v : v d
31 5 fedalAanlionlnanave’a Arduino



6. nmiuaoldlsunsulaelUn  Sketch->Verify / Compile

p
sketch_sep02a | Arduino 1.0.1

File Edit |Sketch|rTooIs Help
Verify / Compile

sketeh Show Sketch Folder
o Import Library...
Ardui] Add File...

This exauple code is in www.EC.in.th.

ks

/ the setup routine runs once when you press reset:
void setup() {
/ initialize serial communication at 9600 bits per second:
Serial.beqgin(9600) ;

/ the loop routine runs over and over again forewver:
void loop() {

/4 print out the walue you read:
Serial.print("“Hello Worldin\r"):;

Arduine Uno on COM19

[
U

tﬂ' k4 k4
31]11 6 ‘lﬁ—!ﬂi’)‘uf’nﬁﬂi')ﬂﬁﬂﬂﬂ?]ﬂgﬂﬂﬂ@ﬂlﬂﬂiﬂﬂ
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4 I Y = 9 o
7. ilonew lWaGeuios v idoanulsingaagil

s - N
sketch_sep02a | Arduino 1.0.1 [E=NEEE

File Edit Sketch Tools Help

sketch_sep02a §

i
/ ,~

Arduino “Hello world"™

This example code is in www.EC.in.th.

*/

/4 the setup routine runs once when you press reset:

volid setup() {
S/ initialize serial communication at 9600 bits per second:
Serial.begin(9600) ;

/ the loop routine runs over and over again forewver:
void loop() {

// print out the wvalue you read:
Serial.print("Hello World\n\r™):;

maximum)

Arduino Uno on COM19

d‘ k4 I 4
31 7 vaasaouzanugndevesiaa
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o y ' 7 A @ a S o
8.Vl'lﬂ'l§!,"§€]uﬁﬂ‘ﬂﬂiﬂ Arduino WL?Wi%@WHL%’Iﬂ‘Uﬂ@MW?m@ﬁW'I‘HVIN‘W@ﬁﬁ USB

d' d' v d Y a d v d
51 8 M3vouAaULIA Arduino I UABNNIABINIUMINDSA USB
g” H @ ﬂ' M 1]
9. iUl N Tools->Serial Port taztaonlnsanuuesa Arduino g1 lFaunldau

) [ 14 . o o
(§M5UV05A Arduino o1 TsunsvazidonlvionTuiia)

p
sketch_sep02a | Arduino 1.0.1

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch
sketch_sep02i  Ey Encoding & Reload
" Serial Monitor Ctrl+Shift=M o
Arduino “He)
Board > |
This exampl [
RS SRR serial Port > com3
COM16
Programmer
/ the setup | v Ccom19 |
woid setup() Burn Bootloader \ - 1
// initialize serial communicatiNg /bits per second:

Serial.begin(9600);
}

// the loop routine runs over and over again forewver:
wvoid loop() {

/4 print out the value you read:
Serial.print({“Hello World\n\r™);
}

< »

Arduine Uno on COM19

~ 2 d qu o d Ay %
31]7] 9 fni!ﬁlf’)ﬂWﬂiVﬂ‘Viﬂiﬁﬂﬂﬂﬂiﬂ‘“ﬂﬂ\‘lﬂ1iﬂl‘lﬁ1u



10. Tnaalisunsumdueda Arduino M1 1FauTaelifn File->Upload

»
sketch_sep02a | Arduino 1.0.1

[E=STE)

Edit Sketch Tools Help

New Ctrl+N

Open... Ctrl+0

Sketchbook »

Examples > =
Close Ctrl+W

Save Ctrl+S

Save As... Ctrl+Shift

Upload Ctrl+U

Upload Using Programmer  Ctrl+Shift:

€U0 bits per second:

Page Setup Ctrl+Shift+P

Print Ctrl+P

Preferences Ctrl+Comma | again forever:
Quit Ctrl+Q

// print out the walue you read:
Serial.print("Hello Worldin\r"):

! @ [ dJ
31 10 Yumeumsdnlvanlnnavesa Arduino

11. 1A uala Serial Monitor Y99 Arduino IDE Iﬂﬁl"lﬂ‘ﬁ Tools->Serial Monitor

= @ﬁ 9 |

-
sketch_Hello_World | Arduinc 1.0.1

File Edit Sketch Help

| Auto Format Ctel+T
Archive Sketch

Fix Encoding & Reload

I* -

Serial Monitor

sketch_Hello_Y

Arduino "
Board

This exaumpl{ z

. X 3 Serial Port »
Programmer »

// the setup |

oid setup() | |
/4 initialize serial communication at 9600 bits per second:
Serial.begin(9600);

Burn Bootloader

// the loop routine runs over and
void loop () {

over again forever:

// print out the wvalue you read:
Serial.print{"Hello Worldin\r");

Arduino Uno on COM19

51U 11 Tueeulumsmenlimsuaawa

e

1171



12. 1ijoiila Serial Monitor 92 ldvennuAsg 1l

r COM19

Hello
Hello
Hellno
Hello
Hello
Hello
Hello
Hello
Hello
Hello
Hellno
Hello
Hello
Hellno
Hello
Hello

World
World
World
World
World
World
World
World
World
World
World
World
World
World
World

1

Autoscroll

fNaﬁneenﬁng v; ﬁéﬂdbaud

- |

v M v o d
51 12 vaaawanlalaandnlvanaauesa Arduino
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{ 3’, U g}z <3 4 g}z < an
pinMode( Mz 19 OUTPUT ) = aam Iamiwilueninnly ldnseundonuazdinea
. A 9 gj 1 Y 2’1 < a 9}2’/ <3 aa
pinMode( vz 19 INPUT ) = asen Iiamimusunnldldnseuaenuaz Adnoa
. . . = £ = % g <3 o Aaa ] ]
digitalWrite( 1179z 19 a0z hozuaas ) = lddeunimiemynadanea I¥ULED %1190
.« . A Y Yo ;’i Y ana [} a 7 < dan
digitalRead( Nz 19 ) = 19dauniusuounnavaea 19U dladna 1duseinsnoa
. d‘ ) 9 & S @ < ' < ¢
analogWrite( 1119z 19 ) = ldevniuihuomuneuden 1wy IC auauaNnui U103

A P 9 VPN < ' Ay < )
analogRead( 51111’]%3161)' )= 1%ﬁqm1uuiuaunweu1aaﬂ %Y RiNDNUT LDR LHULEDITIA
TTYTNN

1 I A Aaa a 9 ] o ] o o o 1
delay( navueuiaaium )= 1%141!’3\‘1!,'JﬂTVIN"Iuﬂ@uﬂ]\i”luﬂ"lﬁﬂﬁﬂllﬂ
. 1 < a = Y 1 o 1 o o & 1
delayMlcrosecondS(Lﬁﬁ"muTJEJUJ‘L!llllIﬂi’JLH1’]) =1%14u’m’mwmmﬂeummmm@m'lﬂ
Y
A o

] 93 o v & 1A 9 Add o A A A3 o A A quy
int = 1903 0A WU FMTUAIAUSHAUN U AN VK IO IDINUTA VA AAVNT DAY D 14107

9}3 A o A Y3 o w dy ~ Y 3 o
char = laaayeanilsnldinuaionys(aeanunlsinuenys)

g 1A i a 1A @ a Jd o 3 a 1A
Serial.begin(9600) = @Nﬂ%iuﬁhlﬁ@@]ﬂ@]@%@ﬁﬁ AUADUN AADTOATUII600TAADIUIN

A

. . o Ja Jo Y 19 o

Sel‘lal.prlnt(“ﬂ?“l/\qllﬂ”) = Gle'WﬂJWﬂﬂQI‘ﬂLW 6],1“!,?{@\1Waﬂui]ﬁ]ﬂﬁ]lll,!,ﬂﬂulllmull'i'i‘ﬂﬂ
. . o v Yya 2o A q 9 Y o

Serlal.prlntln( ANA ) = i“HWMWﬂijﬂLW@GlWLLﬁﬂQWaﬂu%ﬂﬂﬂmlﬂﬂnu UITNA

1A ad 4 1
Serial.available() = 19319 eeUNiimInafdussanse Iy

1 LI 4 4
Serial.Read() = 1¥oUMIjuRdUeIA
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M3l¥auldsunsy Processing

a

Ly TnaaTdsunsu Processing nasf https://processing.org/download/?processing

4
wazhmsaaa 1sunsu

Processing p5.Js Processing.py Processing Foundati

L qugessing

)
JA

AN

Cover Download Processing. Processing is available for Linux, Mac OS X, and
Downlead Windows. Select your choice to download the software below.

3.0

Windows i Linux Mac OS X
Windows Linux

ons covers the differences

Read about the changes in 3.0. The list of rev:
between releases in detail.

3.0 Win 32 / Win 64 /Linux 32 / Linux 64 / MacOS X

i <

51 13 winemaivlsagmSulnaalisunsy Processing

51 14 Tonoulisunsu Processing
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Tosunsu Processing Shortcut

. < o 14 a o v 9YY o A @
Processing Wugennuisszuuila i@ msulaeg ﬂ13WﬁNu’]T‘ﬂillﬂ§ UNYINU

Y

v Jd o 1 { 9 o

9 A A (Ao Y . A
ﬂ1§ﬁ§1\1ﬂ’]WLﬂa@u1W’Jlla$fnil]ﬂaﬁnwu'ﬁ ﬁ’Tﬁi‘UNﬂ!ﬂﬂﬂl‘ﬁ“ﬁﬂwmuﬂﬂiuﬂin Arduino (UD

G Q

[

< 1 9 a 14 . Y YR 9 FY A
mugﬂﬁwuwnmmumanﬂﬁmm Processing um%zgﬁﬂﬂum&mﬂ ANINCIHUDUNU

v 4
7 =}

= & . . Y o = A (2 =
U0 DNNY Processing 1182 Arduino 15%anms lumseu lsunsumrdouni Tasinugiu

Y
a o o < @
NN C/C++ 5')16\3 ﬂ15ﬂ@ﬂﬂﬁﬂwmu1ﬂlﬁﬁ®u ﬂuﬁlaﬂ

sk‘etch_nct31a | Processing 1.5.1 E]@

File Edit Sketch Tools Help

°o n ﬂ m STANDARD umntf (Toelar )

(312 L (Y (Tab)

Y E PER
e hlaviarihlinon

i!uﬁnﬁn"lrl&

i!uf’:l-n“lrl&

1 3 o 1
1eri 1 llaliai R _
nainilylabis VOIS DR 2131 (Text editor)

twvign
E kY

fnlgianm

ERET
"l'll‘ll‘l’l'liilfl 1l {(Message area)

A0UIba (Console)

< A a _
510 15 yaaunIoalion19quealifsunsy Processing

P
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WanFUNUGIUUDI Processing

Y

background() = MIMUUATNUHAIVIN NN TMITLAAS
<3 a Jd 1 b
clear() = 1IuMIATEIMULINMIIMGUNADL AT
< a '
finQ = Wumsianaldzinssaneg
< J o
draw() = (uandulslumsougl

line() = MaraunlFlumsmuuadu T

A o g’/

) & A o A oy Ag o A A Aa o A P A qu
int = 19¥a3%ea s @115 UAIMITUAUNT U AN VKT IDINUTNA VAR VNI AIYD 14107
9/3.” d‘ % d' Y 3 Y dy d' Yy 3 o
char = 1¥a3¥eanisnlyinuaionys(@esnunlyinuenys)
S A o ~ < ) A
float = l9¥aareanilsnlsinuavnilunetio
size() = 1 lumsmuuavamigmanazmmsuanana

o d‘ d’ Y
texe() = slfv%lumimwummmmm NALAS UVUIANABDINITLL AN
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a

d’ 1 a d'
2. IBDULUNUBDEATAANAA

[ Y Y 9 % 9 Y
1A an

INUAIINTITDOULLAT AN Nﬁlﬁﬂlﬁaﬂ

51 17 mawemsiuezn3an
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3111 18 Uszneumueza3andnalany

o = 7 P4 i
4.‘1/]1ﬂ1‘§1ﬁ£“]511!!,°1165 UDIA Arduino t1ae Xbee

~ J d o
31 19 mslavesanluaumsimau
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UIFUUIUNIN

o da
[1] m%mammummauﬂsnsﬂ

< A
http://www.mynpe.com (¢ ULEDIDU W5 5@ (Infrared Sensor))

http://www.thaigoodview.com/node/118154

[2] MSINHYDINISY

http://electronicspocketbook.blogspot.com/2014/01/photo-transistor.html

[3] MIINNUVDIAIAS

http://cpre.kmutnb.ac.th/esl/learning/index.php?article=ir-sender-receiver

[4] naniAvedlaleanla sas (LED)

http://electronics.se-ed.com/contents/112s096/112s096 p07.asp

http://th.wikipedia.org/wiki/%E 0%B9%84%E0%B8%94%E0%B 9%82%E0%B8%AD
%E0%B8%94%%B9%80%E0%B8%9B%E0%B8%A5%E0%B9%88%E0%B8%87%

E0%B9%81%E0%B8%AA%E0%

B8%387

(] d
(5] msl¥anulaleanlaaaaduuesa Arduino

http://www.arduino.cc/en/Tutorial/Blink?from=Tutorial. BlinkingLED



Wil 83

[6] M31¥a1UVB5A Arduino 1B3AY

http://www.thaieasyelec.com/articlewiki/basicelectronics/%E0%B8%9A%E0%B8%97
%E0%B8%84%E0%B8%A7%E0%B8%B2%E0%B8%Alarduino%E0%B8%84%E0
%B8%B7%E0%B8%AD%E0%B8%AD%E0%B8%B0%E0%B9%84%E0%B8%A3
%E0%B9%80%E0%B8%A3%E0%B8%B4%E0%B9%88%E0%B8%A1%E0%B8%9
5%E0%B9%89%E0%B8%99%E0%B9%83%E0%B8%8A%E0%B9%89%E0%B 8%38

7%E0%B8%B2%E0%B8%99-arduino.html

https://www.gravitechthai.com/guru2.php?p=260

[7] 82n3an

http://www.siamchemi.com/%E0%B8%AD%E0%B8%B0%E0%B8%84%E0%B8%A

3%E0%B8%B4%E0%B8%A5%E0%B8%B4%E0%B8%84/

8] 3uAuSauIMBTeuIsunINAIMMB Processing

http://cpre.kmutnb.ac.th/esl/2014/08/learn -programming-with-processing/

[9] Yoy uDI Xbee

http://www.es.co.th/Schemetic/P DF/XBEE-PRO.pdf

[10]Smart Floors
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